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SUMMARY: 21 

We provided a detailed protocol for a standardized method of optic nerve assessment and 22 

quantification using MRI, utilizing a widely available imaging sequence, and open access software 23 

for image analysis. Following this standardized protocol would provide meaningful data for 24 

comparison between different patients and different studies. 25 

 26 

ABSTRACT:  27 

Optic nerve assessment is an important aspect of glaucoma diagnosis and follow-up. This project 28 

describes a protocol for a unified methodology of optic nerve cross-sectional assessment and 29 

quantification using 3 T MRI for image acquisition and ImageJ’s Fiji software for image processing 30 

quantification. Image acquisition was performed using 3 T MRI, with proper instructions for the 31 

patient to ensure straight fixation during imaging. A T2-weighted fat suppressed sequence was 32 

used. A coronal cut taken 3 mm behind the globe and perpendicular to the optic nerve axis should 33 

be uploaded to the software. Using the threshold function, the white matter area of the optic 34 

nerve is selected and quantified, thus, eliminating inter-individual measurement bias. We also 35 

described the normal limits for the optic nerve cross-sectional area according to age, based on 36 

previously published literature. We used the described protocol to assess optic nerve of a 37 

suspected glaucoma patient. The optic nerve cross-sectional area was found to be within the 38 

normal limits, a finding further confirmed via optical coherence tomography of the optic nerve.  39 

 40 

INTRODUCTION:  41 

Glaucoma is an optic neuropathy that is considered to be the most common cause of irreversible 42 

blindness 1. Despite that, it is still poorly understood in terms of its pathophysiology and 43 

diagnosis, with no single standard reference for establishing the diagnosis 2. According to the 44 
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National Institute for Health and Care Excellence (NICE) the diagnosis of primary open-angle 45 

glaucoma (POAG) requires the assessment of multiple domains, including optic disc assessment 46 

on fundus exam or optical coherence tomography (OCT) imaging, visual field assessment, and 47 

intraocular pressure measurement 3. The idea behind diagnosing glaucoma is establishing the 48 

presence of progressing optic neuropathy, which can be done quantitively on OCT 4. In this 49 

regard, MRI can also be used for optic nerve assessment and quantification of its white matter 50 

area 5, but for this to be clinically meaningful, the protocol used in optic nerve white matter 51 

quantification needs to be standardized. Moreover, a protocol should also accommodate inter-52 

individual variation, a factor that might affect accuracy in different diseases 6. 53 

 54 

Optic nerve assessment in glaucoma is optimally assessed via ophthalmic imaging, including OCT, 55 

where the most anterior part of optic nerve (e.g., optic disc) is assessed. On the other hand, the 56 

use of MRI for optic nerve assessment usually assesses the retrobulbar part of optic nerve at 57 

various distances from globe. Several studies found a strong correlation between optic disc 58 

assessment using OCT and MRI 7, 8. However, there is still no unified protocol for optic nerve 59 

assessment and quantification on MRI. Outlining the optic nerve border on MRI has been used 60 

to quantify its cross-sectional area 5. However, this method has considerable inter-rater 61 

variability, as it needs to be done by an experienced rater and requires considerable time for 62 

outlining. The aim of the current project was to provide a protocol for a unified methodology for 63 

optic nerve cross sectional assessment and quantification using 3 T MRI for image acquisition and 64 

ImageJ’s Fiji software for image processing and quantification.  65 

 66 

PROTOCOL: 67 

 68 

The following study was approved by the research committee and institutional review board of 69 

the University of Jordan Hospital. The following protocol will describe the imaging technique used 70 

to acquire MRI images, followed by image processing and optic nerve quantification using Fiji 71 

software. 72 

 73 

1. MRI image acquisition 74 

 75 

NOTE: MR image acquisition was done using a 3 Tesla (3 T) MRI to perform multiplanar T2-76 

weighted fat suppression sequence (Table of Materials). 77 

 78 

1.1. Fully explain the examination to the patient. The following include instructions and 79 

explanations that need to be mentioned to the patient. 80 

 81 

1.1.1. Explain to the patient that they will need to change clothes and wear a special gown for 82 

imaging. 83 

 84 

1.1.2. Have patients remove any worn eyeliner as it can produce artifacts (especially at 3 T) due 85 

to electrical conductivity of the titanium oxide pigment. 86 

 87 

1.1.3. Ensure that the patient does not have any contraindications to perform MRI imaging9: 88 



   

 89 

1.1.3.1. Ask the patient about any metallic materials, which might include face masks, 90 

piercings, artificial limbs, magnetic dental implants, cerebral artery aneurysm clips. 91 

 92 

1.1.3.2. Ask the patient about metallic intraocular foreign bodies. For this, ask the patient 93 

if they have welded without proper protective gear. 94 

 95 

1.1.3.3. Ask the patient about any implantable devices might be incompatible with MRI, 96 

including pacemakers and insulin pumps, analgesic drugs, or chemotherapy pumps. In addition 97 

to this, cochlear implants/ear implant, Implantable neurostimulation systems, Implantable 98 

neurostimulation systems, Catheters with metallic components, are all contraindicated. 99 

 100 

1.1.3.4. Ask the patient about metallic foreign body left inside their body. This includes 101 

bullets, shotgun pellets, and metal shrapnel  102 

 103 

1.1.3.5. Ask the patient about any surgical clips or wire sutures, joint replacement or 104 

prosthesis, inferior vena cava (IVC) filter, ocular prosthesis, stents, or intrauterine device. 105 

 106 

1.1.3.6. Ask the patient if they have gotten a tattoo in the last 6 weeks. 107 

 108 

1.1.3.7. Ask the patient if they have undergone a colonoscopy procedure in the last eight 109 

weeks. 110 

 111 

1.1.3.8. Due to the confined space of the MRI machine, ask the patient if they have 112 

claustrophobia. 113 

 114 

NOTE: Difficulty might be found with patients having high body mass index (BMI). 115 

 116 

1.1.4. Explain to the patient that the exam is expected to take 15 minutes, where the patient 117 

needs to stay still. 118 

 119 

1.2. After completing the instructions and making sure the patient fully comprehends the 120 

exam, obtain a signed consent. 121 

 122 

1.3. During MRI image acquisition, lay the patient supine in the MRI machine, and fixate on a 123 

straight target during imaging without any head movement. For patients with poor visual acuity, 124 

use a sound stimulus to optimize fixation. More comprehensive methods for fixation involve 125 

shutting one eye, use of a fixation target centrally in the form of an LCD screen that changes 126 

colors, and use of ocular lubricants.  127 

 128 

1.4. Ensure that the patient is aware that there is a squeeze button that can be pressed if they 129 

need anything while in the MRI machine. While a head coil can be used, an eye coil and an orbital 130 

coil may be more suited for ophthalmic imaging. 131 

 132 



   

1.5. Input the following parameters for image acquisition: A T2-weighted fat suppression 133 

sequence (TR = 3000 milliseconds; TE = 90 milliseconds; TE = 100; field of view = 16 cm×16 cm; 134 

matrix = 296*384; slice thickness = 3 mm; slice gap = 0.3 mm). The final image analyzed was an 135 

oblique coronal image 3 mm behind the globe. It is important to note that while T2-weighted fat 136 

suppression sequence is generally used for optic nerve imaging, other sequences can be used, 137 

including T2 fast spin echo imaging. 138 

 139 

1.6. Take a coronal cut of the optic nerve orthogonal (i.e., perpendicular) to the nerve 3 mm 140 

posterior to the globe. Use scout images in the transversal and oblique sagittal planes to ensure 141 

optimal optic nerve direction and optic nerve-globe junction positioning. 142 

 143 

1.7. Assess the quality of gaze fixation by CSF distribution around the optic nerve, where it 144 

should be uniformly distributed around the optic nerve with almost equal thickness at all sides. 145 

 146 

1.8. Repeat the process to image the optic nerve for the other side. 147 

 148 

2. Image analysis 149 

 150 

2.1. Download Fiji image processing package from (https://imagej.net/Fiji). 151 

 152 

2.2. Upload the coronal image of optic nerve to ImageJ Fiji software for analysis by clicking 153 

File from the menu bar, followed by Open button. Choose the coronal image to be processed. 154 

Transfer the images to Fiji software without losing image quality during transfer, as image quality 155 

loss will lead to unreliable image analysis results. 156 

 157 

2.3. Standardize the scale by specifying the number of pixels per a unit of length by drawing a 158 

straight line on the map scale. Then choose Set Scale from the Analyze menu bar. Specify the 159 

length of the line as appears on the map scale with the proper unite of length (i.e., mostly mm). 160 

 161 

2.4. Convert the image into a grayscale using the image menu, and then choosing Type and 8-162 

bit. 163 

 164 

2.5. Quantify the range of intensity of white matter pixels. 165 

 166 

2.5.1. Using the Lasso selection tool (Plugin | Segmentation | Lasso tool), select a sufficient 167 

area of white matter, making sure not to include gray matter area during selection. We found 168 

that a total selected white matter area of around 1000 pixels is enough. Use Analyze and 169 

Measure tool to quantify the selected area. 170 

 171 

2.6. Show the Histogram tool from Analyze menu, which shows the distribution of pixels 172 

intensity in the white matter area selected. Click on the Live box to make sure the histogram 173 

assesses the selected area. The graph on the histogram should show a normal distribution of 174 

intensity.  175 

 176 



   

2.7. Calculate white matter intensity range as follows: 177 

Lower limit = mean intensity - (3* standard deviation) 178 

Upper limit = mean intensity + (3* standard deviation) 179 

 180 

2.8. Open the Threshold tool from Image menu, followed by the Adjust function. Specify the 181 

range calculated from the previous step. Tick only dark background function and specify black 182 

and white annotation B&W from drop list, then click apply. The mask for white matter present 183 

within the optic disc will appear. 184 

 185 

2.9. Using the Lasso selection tool (Plugin | Segmentation | Lasso tool), select the black area 186 

representing the optic disc. 187 

 188 

2.10. Use the Measure function from the Analyze menu bar, which will calculate the area 189 

marked by the threshold function in mm. 190 

 191 

REPRESENTATIVE RESULTS: 192 

The cup to disc ratio for a 30-year-old male patient presenting for a checkup ophthalmology exam 193 

was 0.8 (Figure 1A), which is suspicious and might be suggestive of glaucoma. Upon performing 194 

an optical coherence tomography for nerve fiber layer thickness, we found that the nerve 195 

thickness was within the normal limits for age (Figure 1B). The patient was scheduled for an orbit 196 

MRI, where a coronal cut for optic nerve assessment was ordered and performed as per the 197 

abovementioned protocol. 198 

 199 

We obtained a coronal MRI cut, 3 mm behind the optic disc. The white matter mean intensity 200 

was 94.372 (SD 7.085), which resulted in white matter intensity range of: 201 

Lower limit = 94.372 – 21.255 = 73.117 202 

Upper limit = 94.372 + 21.255 = 115.627 203 

 204 

Figure 2 shows the coronal image (Figure 2A), the coronal image after applying the white matter 205 

threshold using the calculated upper and lower limits (Figure 2B), and the optic nerve white 206 

matter for quantification (Figure 2C). The cross-sectional area for the white matter of the left 207 

optic nerve was 6.9 mm2 (0.069 cm2), which is within the normal limits for his age, as shown in 208 

Table 1. 209 

 210 

FIGURE AND TABLE LEGENDS: 211 

Figure 1: Fundus image showing high cup to disc ratio, which might be suggestive of glaucoma 212 

(A). An optical coherence tomography for the nerve fiber layer (NFL) showing a within normal 213 

limits NFL (B). 214 

 215 

Figure 2: Coronal T2 -weighted fat suppressed MRI image obtained perpendicular to the optic 216 

nerve 3 mm behind the optic disc (A). The same coronal cut after applying a pre-calculated 217 

threshold range (B). Optic nerve white matter (C). 218 

 219 

Table 1 shows the normal range of optic nerve cross sectional diameter using MRI 3mm from 220 



   

globe, as found by previous studies. 221 

 222 

DISCUSSION: 223 

We described a protocol to assess and quantify optic nerve white matter that might be used for 224 

glaucoma patient assessment. The protocol uses widely available imaging sequences for image 225 

acquisition, and it uses the open-source Fiji software for image analysis. We standardized the 226 

image parameters that were previously found to be most accurate and highly reproducible in 227 

optic nerve image acquisition, including asking the patient to fixate straight ahead, using T2 with 228 

fat suppression sequence, and capturing the cross-sectional area 3 mm behind the globe. In 229 

addition, we described a detailed image analysis method that eliminates manual segmentation 230 

and corrects for signal variability between patients. The importance of this protocol is that it 231 

eliminates the variation in region of interest (ROI) segmentation by the radiologist, which is 232 

usually the main source of error in optic nerve assessment on MRI 12. While we tried to provide 233 

normative data for optic nerve cross sectional area with Table 1, further data using the standard 234 

protocol described is needed for the use and comparison in clinical settings. Such data need to 235 

accommodate different age groups due to the age variation in optic nerve size, as shown in Table 236 

1. Such variation is not evident between genders 15, but was recently suggested to be present for 237 

refractive error 16. 238 

 239 

Previous studies applied different methodologies for optic nerve white matter quantification, 240 

and they mostly used the software present in their workstation for image analysis. Initial studies 241 

on optic nerve assessment adopted a quantification approach based on cross sectional area, 242 

using manual segmentation by technicians or radiologists 12, 17. Wang et al. also used manual 243 

segmentation of optic nerve cross-sectional area at different distances from the globe for 244 

correlation with OCT 11. Omodaka et al. used the average cross-sectional area on the coronal cut 245 

and the length of the optic nerve from the disc to the optic chiasm on the axial cut through 246 

manual annotation to extract indicators of the optic nerve for correlation with OCT 8. Despite 247 

being correlated with OCT, reproducibility of this method might not yield the required accuracy 248 

for longitudinal assessment of optic nerve. Ramli et al. quantified the volume of the optic nerve 249 

through manual segmentation of the isointense signal at all axial sections 5, an approach that 250 

might miss the optic nerve matter not captured by the axial sections themselves, human error 251 

during image manual segmentation, or even in the determination of the optic nerve length to be 252 

included in the quantification assessment.  253 

 254 

While different studies used the assessment of the cross-sectional area of the optic nerve, they 255 

differed in the distance of measurements from globe. Wang et al. assessed 3 mm, 9 mm, and 15 256 

mm behind the globe, and found that the 3 mm cross-sectional assessment had the highest 257 

correlation with intraocular pressure 11. Bäuerle et al. analyzed the reproducibility of assessment 258 

of the optic nerve on MRI at 3 mm and 5 mm behind the globe, and they found a good assessment 259 

for both cases 10. Lagrèze et al. measured the cross-sectional area 5 mm, 10 mm, and 15 mm 260 

behind the globe and found that the cross-sectional assessment was most accurate in the 5 mm 261 

cross sectional area compared to measurements further from the globe 17. In this protocol, we 262 

used a 3 T MRI for images acquisition, where its use in optic nerve assessment was previously 263 

found to be superior to 1.5 T MRI 18, 19. The increasingly utilized 7 T MRI might also provide 264 



   

superior results but will also require its normative values. Regarding MRI sequence used, we used 265 

T2 fat suppression sequence, mainly due to its wide availability and its inherent ability to 266 

delineate the optic nerve surrounding CSF after eliminating the surrounding intraconal fat. 267 

Previous studies used other sequences with reliable results, including the half-Fourier single-shot 268 

turbo spin-echo (HASTE) sequence and Diffusion Tensor Imaging (DTI) sequence 7, 12, which might 269 

not be widely available.  270 

 271 

An important aspect to consider during image acquisition is making sure that the patient is 272 

fixating on a straight target, as fixating on a non-straight target during imaging will yield a non-273 

accurate optic nerve quantification 12. Fixation in OCT is monocular on a close target, requiring 274 

the patient to have good visual acuity in the eye to be assessed to see the near target with one 275 

eye, whereas for MRI the target is further away, the fixation is binocular, and requires fewer 276 

visual demands. However, fixation might still be an issue for patients who have high refractive 277 

error or poor vision. While the use of MRI to assess and follow patients with glaucoma might not 278 

be feasible in the presence of low cost, simpler imaging techniques, including the OCT, MRI can 279 

be useful in special situations where OCT do not provide conclusive data, or OCT itself cannot be 280 

obtained, such as in the presence of significant ocular medial opacity. Furthermore, the described 281 

protocol can be used when MRI imaging is warranted in cases of unexplained optic neuropathy 282 

to exclude secondary causes 20, 21.  283 

 284 

One of the main limitations of this protocol is the inability to assess patients who cannot properly 285 

fixate, including patients with poor visual acuity in both eyes. In this regard, the use of sound 286 

stimulus will improve the quality of fixation during image acquisition 22. Moreover, as a new 287 

methodology, future studies are needed to depict normal values for MRI-based cross-sectional 288 

areas for optic nerve white matter. The importance of establishing normal values is further 289 

stressed by the fact that optic nerve is also composed of significant amount of connective tissue 290 
23, a tissue that does not have similar functional abilities as nerve fibers. While quantification of 291 

optic nerve fiber layer thickness in OCT might provide a false impression of remanent nerve tissue 292 

due to the inclusion of connective tissue in the quantification process 24, such a false impression 293 

is not present in this MRI-based quantification method. Motion artifacts might also lead to blur 294 

in images, especially upon eye movement during exam. While it should be avoided during 295 

imaging, establishing white matter range will reduce the impact of such artifacts on the accuracy 296 

of optic nerve white matter quantification, as the changes caused by the motion artifact on 297 

cerebral white matter is almost like the optic nerve’s white matter. 298 

 299 

The main strength of the current protocol is the elimination of inter-individual differences during 300 

optic nerve quantification, even when performed by non-specialized medical doctors or 301 

technicians. In addition, it used a widely available open-source software for image analysis. While 302 

it is not feasible to do a dedicated MRI imaging for optic nerve quantification, especially in the 303 

presence of the OCT, it is recommended to perform this protocol during MRI imaging done for 304 

other purposes, including the exclusion of secondary causes of optic neuropathy and glaucoma.  305 

 306 
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Study Sample size Age (Years)
Mean cross sectional 

area (mm2)
Imaging sequence

Bäuerle, 2013. 10 15 Mean (SD) 24.5 ± 0.8 5.69 ± 0.77 T2-weighted turbo spin echo (TSE) sequence

Wang 2012. 11 21 Mean (SD) 51.6±12.0 5.03 ± 0.35
T2-weighted fast recovery fast spin echo (FRFSE) 

sequence

Weigel, 2006. 12 32 Mean (range) 25 (22–39) 5.7 ± 0.6 T2-weighted turbo spin echo (TSE) sequence

Yiannakas, 2013. 
13 8 Mean (range) 31 (29–33) 6.2 (1.3) T2-fat-suppressed

Al-Haddad, 2018. 
14 211

Median (interquartile) 8.6 

(3.9–13.3)
4.0 ± 0.20 * T1-weighted inversion recovery sequence

*Calculated using the provided optic nerve diameter.
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